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keeping. 
 
Limitation of Liability 
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assumes no responsibility for errors and/or omissions nor for the uses of the material and the decisions 
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document, its merchant ability or fitness for a particular purpose. The author should not be liable for 
direct, indirect, special, incidental or consequential damages arising out of the use or inability to use the 
contents of this document. 
 
Special Note 
 
All of the work presented within this tutorial is based on TurboCAD Pro V19.1 (64-Bit). Although users of 
previous versions are welcome to try the tutorial it cannot be stated what results will be achieved. Many 
changes, some subtle and others not so subtle, are made with each program revision. Although many 
steps and directions would be generic some may not be. The same can be said for tools between 
versions. Older versions may not have the same tools as Pro V19.1 and if the same tools are available 
the tools themselves may have been revised and hence, work in a different manner than they previously 
did. 
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Introduction 
 
TurboCAD is very well suited for Mechanical Drafting with its myriad tools and functions that make the 
job so easy. With each new version that hits the market the professional user will readily notice how 
much effort has been put into developing and fine tuning this wonderful CAD package. TurboCAD Pro, 
now with a 64-Bit version, means that a user can tackle the most complex assemblies knowing full well 
that the program will deliver. 
 
The Finger Press Engine tutorial was created especially for those with a bent toward mechanical drafting. 
It is a very comprehensive review that leads the reader through a full project that outputs fifteen pages of 
blueprints ready for the manufacturing floor. It includes instructions on creating the model in all its 3D 
glory, creating an exploded view, getting the model to paper space and even creating a bill of materials.   
 
Paper space output is based on the mechanical style the author uses in his daily work with clients within 
the manufacturing industry. 
 
This tutorial is in no way intended to teach mechanical design or drafting standards but rather it is 
intended to teach the use of some of the tools that TurboCAD has to offer and to introduce the new user 
to a drawing methodology. The author feels confident that the techniques outlined within the tutorial can 
help lay the foundation for future successful TurboCAD drawing and illustration for even the newest user. 
 
As with any technically advanced software, the user is generally faced with a steep learning curve. It is 
the hope of the author that the money and time spent working through a Textual Creations tutorial will 
help ease the learning and allow the reader to come away feeling confident that they made a wise 
decision. 
 
This tutorial will assume that the reader has the Platinum edition of TurboCAD Pro V19.1 (64-Bit). 
Although no architectural specific tools are used, some mechanical specific ones are (Add Hole & 
Thread). Note that the author has added notes to indicate what can be done in lieu of these tools. The 
author does not have the 32-Bit version of TurboCAD V19, but did save the final drawing back to v18. The 
model opened and rendered in V18 (which is 32-Bit) without issue (providing ACIS is set to draft), so 
using V19 (32-Bit) for this tutorial should pose no problems. 
 
There are many ways to approach a project and it is likely that each person using the program would 
proceed in very different ways, so be open to alternative methods as experience builds. 
 
This tutorial assumes that the beginner has studied the desktop to some degree and can locate most of 
the tools. Since there are endless desktop configurations that can be set up in TurboCAD the author has 
opted to illustrate the required tools with the TurboCAD Classic user interface with its Office 2003 theme 
and the default toolbars in their undocked format. 
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Please remember that any supplied images and files are for use within the tutorial only and may not be 
shared or sold to others. 
 
For those working through the tutorial in pre-V18 versions please note that most of the functions 
described in the tutorial, as being on the Modify menu, were on the Format menu in previous versions of 
the program. 
 
Also note that render times are much better in V18 and V19 than one will see if using previous versions 
of TurboCAD. TurboCAD now uses Multi-Threading for renders and can make use of multiple processors. 
The author has a fairly new Acer with 6 processers and has enabled 5 for rendering. This is looked at as 
part of the set up further along. 
 
Lastly, the Copy in Place tool has finally been reintroduced into TurboCAD as a permanent tool. Users 
who don't have this new tool will need to use the Make Copy method. That is to select the object to copy 
in place, select the Make Copy tool to turn it on, tab into the first field on the Inspector Bar – but don't 
change anything – and simply press Enter. Select the Make Copy tool again to turn it off. 
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Wood Base 
 
Select the Box tool from the 3D Object toolbar. 
 
Left mouse click in the drawing to place the first point of the box. Tab into the Inspector Bar and enter 5 
in the Width field, 5 in the Length field and .75 in the Height field. Press Enter. 
 

 
 
Press the Space Bar to exit the tool. 
 
Select the box. Tab into the Inspector Bar and enter 0 in the X and Y Position fields. Press Enter to move 
the box to the center of the drawing. 
 

 
 
Select Zoom Extents at the top of the TurboCAD desktop if need be. 
 
Select the Fillet Edges1 tool from the 3D Modify toolbar. 
 

 
 
Tab into the Inspector Bar and enter .125 in the Start Radius field. Press Enter. 
 

 
 
Select the box as the object to fillet. Drag the selection cursor around all blue nodes as the edges to fillet. 
Select Finish. In progress below. 

 

    

                                                 
1 When the object is selected for chamfering or filleting blue nodes appear at each edge that can be chamfered or filleted. A 
left click on the desired edge changes the node to red indicating that it will be chamfered or filleted when the Finish icon is 
engaged. Left mouse clicking the edge again it will turn the node back to blue and as such will not be chamfered or filleted. At 
times it is best to select only a couple or so edges at a time to chamfer or fillet otherwise the procedure cannot be calculated 
by the program. Also of importance is the fact that if two connecting edges are selected the common third edge will also be 
selected and a green node will appear. This indicates that the edge with the green node will also be chamfered or filleted. Also 
note that if the cursor is hovered over a selected edge it will preview the chamfer or fillet. Although not in this case, it can be 
difficult to see clearly what edges are to be chamfered or filleted but if one takes one's time success can be achieved. 
Sometimes rotating the view or switching to Suppress Hidden Line or Draft Rendering mode can help with edge identification. 

To select, left mouse click upper left 
(away from model) and hold the 
mouse button down. Drag the cursor 
to the lower right, as indicated, and 
then release the mouse button. 
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Post 
 
The main post will now be created. 
 
Select the Box tool from the 3D Object toolbar. 
 
C SEKE snap the upper edge of the left hole to place the first point of the box. Tab into the Inspector Bar 
and enter .75 in the Width field, .5 in the Length field and 3.5 in the Height field. Press Enter. 
 

 
 
Press the Space Bar to exit the tool. 
 
Select the new box. Tab into the Inspector Bar and enter 0 in the X and Y Position fields. Press Enter to 
center the post. 
 

 
 
Press Esc to deselect the selection. 
 
Hole locations or holes will now be marked. 
 
The first will be for the holes at the bottom of the post. Several ways exist to place these markers, but 
here it will be done by first moving the workplane to the bottom of the post, which is currently at the 
bottom of the base. 
 
Select the WorkPlane Origin tool from the Workplane toolbar. 
 

 
 
C SEKE snap the upper circle of the hole, as indicated in the picture below, to move the workplane. In 
progress below. 
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Select the Fillet Edges tool from the 3D Modify toolbar. 
 
Tab into the Inspector Bar and enter 1/64 in the Start Radius field. Press Enter. 
 

 
 
Select the post as the object to fillet. Select the four vertical lines and one of the top lines as the edges to 
fillet. Select Finish. In progress below. 
 

 
 
Press the Space Bar to exit the tool. 
 
Create a new layer called Post. 
 

 
 
Press Ctrl + T to open the Select by Entity Type dialogue. Select Point and click OK. 
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Select the Simple Extrude tool from the 3D Objects toolbar. 
 

 
 
Select the red rectangle as the object to extrude. Tab into the Inspector Bar and enter -.75 in the Height 
field. Press Enter. 
 

 
 
Select the 3D Subtract tool from the Boolean & Facet toolbar. 
 
Select the shaft as the object to subtract from and then select the extrusion as the object to subtract. In 
progress below. 
 

 
 
Press Ctrl + K to open the Select by Colors dialogue. Select Red and click OK. 
 

 
 
Assign the selection to the 2D layer. 
 
Create a new layer called Shaft. 
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Press the Space Bar to exit the tool. 
 
Switch to Isometric SE view. 
 
Select Plane by World from the Workplane toolbar. 
 
Create a new called Flywheel. 
 

 

www.textualcreations.ca


Donald B. Cheke                                                                                                                                                                                                       www.textualcreations.ca 

 77

Select the flywheel and assign it to the Flywheel layer. 
 
Press Esc to deselect the selection. 
 
Turn on all layers, except 2D for a look so far. 
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With the first bolt still selected. Tab into the Inspector Bar and enter 270 in the X Rotation field. Press 
Enter. 
 

 
 
Select the second bolt. Tab into the Inspector Bar and enter 90 in the Y Rotation field. Press Enter. 
 

 
 
The forward bolt will be subtracted but not kept. The rear bolt will be subtracted but kept and later be 
turned into the set screw. 
 
Select the 3D Subtract tool from the Boolean & Facet toolbar. 
 
Select the crank as the object to subtract from and then select the forward bolt as the object to subtract. 
In progress below. 
 

 
 
Select the Don't remove the subtrahend option. 
 
Select the crank as the object to subtract from and then select the rear bolt as the object to subtract. In 
progress below. 
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Select the smaller rectangle and delete it. 
 
Switch to Isometric SE view. 
 
Select the Simple Extrude tool from the 3D Object toolbar. 
 
The Use Compound Profile option should still be engaged. 
 

 
 
Press and hold the Shift key down. 
 
Select the chamfered rectangle and the circle. Release the Shift key. Tab into the Inspector Bar and enter 
.25 in the Height field. Press Enter. 
 

 
 
Press the Space Bar to exit the tool. 
 
Select the lever. Press D SEKE and relocate (C SEKE) the reference point to the inside of the hole. 
 

 
 
Turn on the 2D layer and turn off the Post layer. 
 
Left mouse click on the reference point of the selection to pick it up. Move the cursor to the center of the 
cross point, as indicated in the picture below, and V SEKE snap to place the selection. In progress below. 
Do not deselect. After the snap note how the profiles moved along with the selection. This due to the fact 
that the Use Compound Profile option had been engaged. The link will be broken when other operations 
are performed on the lever. 
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Select the crank. 
 
Double click the number in the X Position field to select it. 
 

 
 
Press Ctrl + C to copy it. 
 
Press Esc to move out of the Inspector Bar. 
 
Select the lever. Right mouse click and select Default Reference Point from the local menu. 
 
Tab into the Inspector Bar and paste (Ctrl + V) the copied number into the X Position field. Press Enter. 
 

 
 
Turn off the 2D layer and the Crank and Set Screw layer. 
 
Press Ctrl + K to open the Select by Colors dialogue. Select Red and click OK. 
 
Assign the selection to the 2D layer. 
 
To help with screw hole placement, select the Auto Workplane by Face tool from the Workplane toolbar. 
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Press the Space Bar to exit the tool. 
 
Turn on the Tap Bolt layer. 
 
Switch to Isometric SE view. 
 
Select the tap bolt and then select the Copy in Place tool one time.
 
Assign the selection to layer 0. In progress below.
 

 
Turn off the Tap Bolt layer. 
 
With the layer 0 screw still selected, Tab into the Inspector Bar and enter
Enter. 
 

 
Switch to Isometric NW view. 
 
Press D SEKE and relocate (C SEKE) the reference point to
below. 
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elect the Copy in Place tool one time. 

In progress below. 

  

Tab into the Inspector Bar and enter 90 in the Y Rotation fi

 

Press D SEKE and relocate (C SEKE) the reference point to the circle at the end of the bolt. 
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90 in the Y Rotation field. Press 

the circle at the end of the bolt. In progress 
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Left mouse click on the reference point of the selection to pick it up. Move the cursor to the edge of the 
lower left hole circle of the base, as indicated in the picture below, and C SEKE snap to place the 
selection. Do not deselect. In progress below. 
 

 
 
Right mouse click and select Rubber Stamp from the local menu. Move the cursor to the edge of the 
lower right hole circle, as indicated in the picture below, and C SEKE snap to place the selection. 
 

 
 
Press Esc to exit the Rubber Stamp tool. 
 
Press Esc to deselect the selection. 
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General & Custom Attributes 
 
A number of attributes are going to be applied to the parts. Applying a general attribute will make it easy 
to select certain parts in drafting palette views when creating alternating hatch patterns. Custom 
attributes are used to create Bills of Materials. Going through this whole process for every model is 
certainly not necessary but it is good to know when a time arises that it is necessary. 
 
It is now time to create the custom attributes that will be used for the creation of the eventual bill of 
materials. 
 
Some consideration must be made. Does one select only one of the multiple items (like the base screw) 
and insert the total number? Does one assign it to all instances? The author feels that the latter is the 
best approach, especially if one will be exporting to a spreadsheet where changes are easy to make. By 
selecting all instances, one is sure not to miss anything in the long run and can find the attributes by 
selecting any one of the components. The bearings are a different story. The author feels that only the 
outer ring should receive the attributes since they are comprised of so many parts. 
 
Custom Attributes are created via the Database function under the Tools menu. TurboCAD does not allow 
a user to reorganize the fields in the Properties dialogue but they can be reorganized when creating the 
report. A user will also find they cannot be reorganized on the Selection Info palette either once they 
have been created.  As this is the case, it is important to figure out what the desired outcome should be 
before putting in all the effort to input the desired fields. Hopefully this will make sense as the tutorial 
proceeds. Try not to make spelling errors as they are not easily fixed, not without recreating and losing 
the current organization. 
 
From the Tools menu at the top of the TurboCAD desktop select Database and Define Fields. 
 

 
 
Left mouse click into the first Field Name slot. Type Part Name. 
 
Left mouse click into the first Data Type slot. Text pops up and is what is desired. 
 

 
 
Left mouse click below Part Name to create a new slot. Type Quantity. 
 
Left mouse click into the next Data Type slot. Text pops up. Select the drop down menu arrow and then 
select Integer. 
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Diameter can be skipped in this instance.
 
Enter Beech Hardwood in the Material Type field
attribute was not changed in the tutorial. As with other attributes, it can be changed in the BOM
 
Enter Stained - Lacquered in the Material Finish field. 
 
Enter Hardwood Haven in the Vendor field (fictitious name made up for tutorial). 
 
Enter .04 for price per square inch (~ $5.25 Brd/Ft tax included). 
accurate. Prices are simply used for example data
 
$ per Cu Inch can be skipped in this instance.
 
Total Cost Material can be left blank if one plans on using Excel or other spreadsheet software that can 
read xls files and has math functions like Ex
will be following through with that. If the user does not have Excel or other spreadsheet software then 
they would need to calculate the cost manually as the table that can be inserted into the T
drawing, based on the eventual report, does not have this capability.
 
Click OK. 
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Diameter can be skipped in this instance. 

Enter Beech Hardwood in the Material Type field. (What is eventually used is 
attribute was not changed in the tutorial. As with other attributes, it can be changed in the BOM

Lacquered in the Material Finish field.  

Enter Hardwood Haven in the Vendor field (fictitious name made up for tutorial).  

Enter .04 for price per square inch (~ $5.25 Brd/Ft tax included). Any prices used 
Prices are simply used for example data in the tutorial. 

can be skipped in this instance. 

Total Cost Material can be left blank if one plans on using Excel or other spreadsheet software that can 
read xls files and has math functions like Excel. This tutorial will assume that the reader has Excel and 
will be following through with that. If the user does not have Excel or other spreadsheet software then 
they would need to calculate the cost manually as the table that can be inserted into the T
drawing, based on the eventual report, does not have this capability. 
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is likely Cherry, but this 
attribute was not changed in the tutorial. As with other attributes, it can be changed in the BOM).  

prices used throughout may not be 

Total Cost Material can be left blank if one plans on using Excel or other spreadsheet software that can 
cel. This tutorial will assume that the reader has Excel and 

will be following through with that. If the user does not have Excel or other spreadsheet software then 
they would need to calculate the cost manually as the table that can be inserted into the TurboCAD 
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Click OK to exit the Material Editor and click OK to exit the Properties dialogue. 
 
Press Esc to deselect the selection. 
 
Open the Design Director and select the layer names (press and hold the Ctrl key while selecting), as 
indicated in the picture below, and then select the Select By icon at the top of the palette. 
 

 
 
Open the Properties dialogue for the selection.  
 
Under the Material tab select Edit Material. 
 

 
 
Right mouse click over the yellow Metals folder and select New Material.  
 

 
 
Enter FPE Polished in the Material Name field of the Enter Material Name dialogue that opens and click 
OK. 
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Expand Metals and expand the new material at the bottom of the Metals category list. 
 

 
 
Select the Pattern tab. Left mouse click the color box to open the Select Color dialogue. Enter a Value of 
47. Click OK. Select Default View 
 

 
 

 
 
Select the Reflectance tab in the window on the left. From the Shader dropdown menu select Conductor. 
Adjust the settings to reflect those in the image below. 
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Left mouse click each of the three Environment tabs and ensure settings all three settings are as 
indicated in the picture below. This setup will reflect the light probe from the three sides, but it will not be 
visible as an image in the background since plain is set for that shader. 
 

 
 
Click OK to exit the Render Scene Environment Editor and click OK to exit the Drawing Setup dialogue. 
 
Allow time for the screen to render (11 second on the author's off the shelf Acer). 
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Select the crank and the set screw of the exploded model. Tab into the Inspector Bar and enter 2 in the 
Delta X field. Press Enter. 
 

 
 
Select the right bearing. In progress below. 
 

 
 
Tab into the Inspector Bar and enter 1 in the Delta X field. Press Enter. 

 

 
 
Select the set screw of the exploded model. Tab into the Inspector Bar and enter .75 in the Delta Y field. 
Press Enter. 
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It is now time to create the formulas to calculate the costs. 
 
Select the Total Cost Material cell for the Wood Base (M2). 
 

 
 
In the fx line near the top of the desktop (or type right in the cell), remove the 0 and type =d2*e2*k2. 
Press Enter. 
 

                 
 
Select the Total Cost Material cell for the Post (M3). 
 
In the fx line near the top of the desktop remove the 0 and type =d3*e3*f3*l3. Press Enter. 11 cents 
seems totally unrealistic so it will be changed. Another web search turned up something that said a 
person can expect to pay up to a dollar per cubic inch for aluminum. This seems more reasonable, so this 
will be changed to .90 per cubic inch.  
 
Left mouse click into cell L3 and type .90. Press Enter. 
 

  
 
It looks like it could be handy to have a 'unit cost' for some things such as the bearings and bolts. 
 
Right mouse click over the M header and select Insert. 
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Press Esc to deselect the selection. 
 
Select Zoom Full View. 
 

 
 

 
 
Double click the table (at edge) to open the spreadsheet in the drawing. Under the View tab, uncheck 
Gridlines. 
 

 
 
Left mouse click in an area in the drawing away from the table to close it. 
 
Press Esc to deselect the selection. 
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Move the cursor in a downward direction for a short distance. The dimension currently reads the actual 
paper space size. It will switch to associate with what is in model space after it is completely placed. 
 

 
 
Tab into the Inspector Bar and enter .4 in the Length field. Press Enter. Be sure to use Inspector Bar 
entries or snaps for precision placement. 
 

 
 

 
 
Note too, that V16 was the first version to use associative dimensions with DP inserts. Previously, a user 
would need to adjust the scale under the dimension Properties dialogue. 
 
Using two V SEKE snaps at the right side of the same DP object, place the first two points of the next 
dimension. In progress below. 
 

 
 
Move the cursor to the right for a short distance. Tab into the Inspector Bar and enter .8 in the Length 
field. Press Enter. 
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Select Zoom Full View. 
 
Select and delete the DP objects and the dimensions. 
 
Four drafting palette objects will now be inserted. 
 
On this page the DP objects are going to be placed wide. This is going to be done to simulate what 
happens when a user finds out that a larger sheet is required. It is actually not too big a deal to change in 
TurboCAD, but it is something important to know. 
 
Open the Drafting palette. 
 
Select Part: Lever. 
 

 
 
Select Plan View. 
 

  
 
Select the Add icon at the top of the palette. 
 
With the Plan Entity CS title still selected, select the Insert into Drawing icon at the top of the palette.  
 
Move the cursor to the grid intersection X=3, Y=3.5 and G SEKE snap to place the DP object. In progress 
below. 
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Page 11 – Finger Pad 
 
The finger pad drawing will be placed on an A size sheet. 
 
To illustrate that any sheet can be duplicated, select the Connecting Rod tab (it is A size). 
 

 
 
Right mouse click on the Connecting Rod tab at the bottom of the TurboCAD desktop and select 
Duplicate. 
 
Select the Connecting Rod 1 tab. 
 

 
 
Right mouse click over the Connecting Rod 1 tab and select Rename. 
 
Type Finger Pad and click OK. 
 

 
 
Right mouse click over the Finger Pad tab and select Properties. 
 
Under the Page Setup tab set the Printer / Plotter, if need be. Click OK. 
 
Zoom in on the title block. 
 
Double click on the Title CONNECTING ROD to open the Properties. Type Finger Pad and click OK. 
 

 
 
Double click on the Scale 1:1 text to open the Properties. Replace the first 1 with a 2 and click OK. 
 

 
 
Press Esc to deselect the selection. 
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To help create the section view, select the Line tool from the Line toolbar. 
 
Using two G SEKE snaps, place the line horizontally through the left view DP object. 
 

 
 
Select Create by ViewLine on the Drafting palette 
 
Select the left view DP object as the drafting object and then select the horizontal line.  
 

 
 
Move the cursor down and then left mouse click to define the direction. In progress below. 
 

 
 
Select the Aligned Sectional View on the Drafting palette and select Insert into drawing at the top of the 
palette. 
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Move the cursor over the left view drafting palette (DP) object to align them and then move the cursor to 
the grid intersection X=4.5, Y=8 and G SEKE snap to place the DP object. 
 

  
 

A Fragmental view will now be created. 
 
Select the Circle Center and Point tool from the Circle/Ellipse toolbar. 
 
Zoom in on the center of the full left view DP object. 
 
G SEKE snap the grid intersection, as indicated in the picture below, to place the first point of the circle. 
 

 
 
Tab into the Inspector Bar and enter 1.5 in the Diameter field. Press Enter. 
 

 
 
Press the Space Bar to exit the tool. 
 
Select Create Fragmental View at the top of the Drafting palette. 
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Double click on the section view to open the Properties dialogue. Under the Section Brush tab, expand 
the Part of projection menu. If the reader recalls, all the parts, with the exception of the ball bearings 
(spheres) and inner ring of the ball bearing were assigned their name as the General Attribute. If nothing 
had the general attribute assigned then all parts would simply have had the source id numbers like the 
spheres and the inner ring below, making it impossible to select something specific. 
 

 
 
With the dropdown still opened, select Shaft. In progress below. 
 

 
 
Enter an Angle of 90. 
 

 
 
Under the Format tab, check Don't show hidden lines. Click OK. 
 
Now the shaft hatch is opposite to the key and the bearings. 

Order and Source ID 
numbers will be different 
for the reader. 
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